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[bookmark: _Toc68181632]JURISDICTION
This Administrative Settlement Agreement and Order on Consent (“Settlement Agreement”) is issued pursuant to the authority vested in the President of the United States by Section 122(g)(4) of the Comprehensive Environmental Response, Compensation, and Liability Act (CERCLA), as amended, to reach settlements in actions under Section 106 or 107 of CERCLA. The authority vested in the President has been delegated to the Administrator of the U.S. Environmental Protection Agency (EPA) by Executive Order 12580, 52 Fed. Reg. 2923 (Jan. 29, 1987), and further delegated to the Regional Administrators of EPA by EPA Delegation No. 14-14-E (De Minimis Settlements) [insert reference to Regional redelegation, if any].
This Settlement Agreement is issued to the persons, corporations, or other entities identified in Appendix A (“Respondents”) [if Settling Federal Agencies (SFAs) insert: and to [insert names of SFAs or reference attached Appendix] (“Settling Federal Agencies”)]. Each Respondent [and each Settling Federal Agency] agrees to undertake all actions required by this Settlement Agreement. Each Respondent [and each Settling Federal Agency] further consents to and will not contest EPA’s jurisdiction to issue this Settlement Agreement or to implement or enforce its terms.
EPA [and] Respondents [, and Settling Federal Agencies] agree that the actions undertaken by Respondents [and Settling Federal Agencies] in accordance with this Settlement Agreement do not constitute an admission of any liability by any Respondent [or any Settling Federal Agency]. Respondents [and Settling Federal Agencies] do not admit, and retain the right to controvert in any subsequent proceedings other than proceedings to implement or enforce this Settlement Agreement, the validity of the Statement of Facts or Determinations contained in Sections V and VI, respectively, of this Settlement Agreement. 
[bookmark: _Toc68181633]PARTIES BOUND
This Settlement Agreement shall apply to and be binding upon EPA [, the United States on behalf of Settling Federal Agencies,] and upon Respondents and their [heirs,] successors and assigns. Any change in ownership or corporate or other legal status of a Respondent, including but not limited to, any transfer of assets or real or personal property, shall in no way alter such Respondent’s responsibilities under this Settlement Agreement. Each signatory to this Settlement Agreement certifies that he or she is authorized to enter into the terms and conditions of this Settlement Agreement and to execute and bind legally the party represented by him or her.
[bookmark: _Toc68181634]STATEMENT OF PURPOSE
[NOTE: As drafted, this Statement of Purpose assumes that all Respondents (and SFAs, if any) are making a cash payment, which includes a premium amount, in exchange for a full and final settlement with EPA for all civil liability under CERCLA §§ 106 and 107 with respect to the Site as a whole. This Statement of Purpose will need to be amended if the settlement is of narrower scope with respect to some or all Respondents (or SFAs) because, e.g., it relates to only one operable unit, or it includes a reservation of rights for cost overruns. When using this or any other Statement of Purpose, be sure that the provision is consistent with the Covenants by United States, the Reservations of Rights by United States, and the definition of “matters addressed” in Paragraph 35.]
By entering into this Settlement Agreement, the mutual objectives of the Parties are:
to reach a final settlement among the Parties with respect to the Site pursuant to Section 122(g) of CERCLA, 42 U.S.C. § 9622(g), that allows Respondents [and Settling Federal Agencies] to make a cash payment, including a premium, to resolve their alleged civil liability under Sections 106 and 107 of CERCLA, 42 U.S.C. §§ 9606 and 9607, for injunctive relief with regard to the Site and for response costs incurred and to be incurred at or in connection with the Site, thereby reducing litigation relating to the Site;
to simplify any remaining administrative and judicial enforcement activities concerning the Site by eliminating a [substantial] number of potentially responsible parties from further involvement at the Site; and
to obtain settlement with Respondents [and Settling Federal Agencies] for their fair share of response costs incurred and to be incurred at or in connection with the Site by the EPA Hazardous Substance Superfund, and by other persons, and to provide for full and complete contribution protection for Respondents [and Settling Federal Agencies] with regard to the Site pursuant to Sections 113(f)(2) and 122(g)(5) of CERCLA, 42 U.S.C. §§ 9613(f)(2) and 9622(g)(5), or as otherwise may be provided by law. 
[bookmark: _Toc68181635]DEFINITIONS
[bookmark: _Ref376859757]Unless otherwise expressly provided in this Settlement Agreement, terms used in this Settlement Agreement that are defined in CERCLA or in regulations promulgated under CERCLA shall have the meanings assigned to them in CERCLA or in such regulations. Whenever terms listed below are used in this Settlement Agreement or in any appendix attached hereto, the following definitions shall apply:
“CERCLA” shall mean the Comprehensive Environmental Response, Compensation, and Liability Act, as amended, 42 U.S.C. §§ 9601-9675.
“Day” or “day” shall mean a calendar day. In computing any period of time under this Settlement Agreement, where the last day would fall on a Saturday, Sunday, or federal or State holiday, the period shall run until the close of business of the next working day.
“Effective Date” shall mean the effective date of this Settlement Agreement as provided by Section XVII.
“EPA” shall mean the U.S. Environmental Protection Agency.
“EPA Hazardous Substance Superfund” shall mean the Hazardous Substance Superfund established by the Internal Revenue Code, 26 U.S.C. § 9507.
“Interest” shall mean interest at the rate specified for interest on investments of the EPA Hazardous Substance Superfund established by 26 U.S.C. § 9507, compounded annually on October 1 of each year, in accordance with 42 U.S.C. § 9607(a). The applicable rate of interest shall be the rate in effect at the time the interest accrues. The rate of interest is subject to change on October 1 of each year. Rates are available online at https://www.epa.gov/superfund/superfund-interest-rates.
“National Contingency Plan” or “NCP” shall mean the National Oil and Hazardous Substances Pollution Contingency Plan promulgated pursuant to Section 105 of CERCLA, 42 U.S.C. § 9605, codified at 40 C.F.R. Part 300, and any amendments thereto.
“Paragraph” shall mean a portion of this Settlement Agreement identified by an Arabic numeral or an upper- or lower-case letter.
“Parties” shall mean EPA [and the] [,] Respondents [, and Settling Federal Agencies].
“RCRA” shall mean the Solid Waste Disposal Act, as amended, 42 U.S.C. §§ 6901-6992 (also known as the Resource Conservation and Recovery Act).
“Respondents” shall mean those persons, corporations, or other entities listed in Appendix A. [NOTE: Instead of listing the name of each Respondent in Appendix A and the amount of payment by each Respondent in Appendix C, Regions may choose to create one Appendix to serve both purposes.]
“Section” shall mean a portion of this Settlement Agreement identified by a Roman numeral.
“Settlement Agreement” shall mean this Administrative Settlement Agreement and Order on Consent and all appendices attached hereto. In the event of conflict between this Settlement Agreement and any appendix, the Settlement Agreement shall control.
 [NOTE: If SFAs, insert the following definition.]
[“Settling Federal Agencies” shall mean [insert names of specific federal entities whose liability is being resolved to make clear that only those entities and each of their direct successors is included] and their successor departments, agencies, or instrumentalities.][footnoteRef:1] [1:  If the Region has any information suggesting federal agency liability, such information should be provided to DOJ as soon as possible. For information regarding CERCLA § 104(e) information requests to federal agencies, review the “Guidance on Issuing CERCLA Section 104(e)(2) Information Requests to Federal Agencies at Privately-owned Superfund Sites” (June 14, 2004), available at https://www.epa.gov/enforcement/guidance-issuing-superfund-104e2-information-requests-federal-agencies-privately-owned.] 

“Site” shall mean the ______ Superfund Site, encompassing approximately____ acres, located [insert address or description of location] in [insert City, County, State] and [insert either: “generally shown on the map attached as Appendix B” or “generally designated by the following property description:______.”]
“[Site name] Special Account” shall mean the special account, within the EPA Hazardous Substance Superfund, established for the Site by EPA pursuant to Section 122(b)(3) of CERCLA, 42 U.S.C. § 9622(b)(3), and [if applicable, identify prior settlement under which EPA established the special account].
“State” shall mean the State [or Commonwealth] of ______.
“United States” shall mean the United States of America, and each department, agency, and instrumentality of the United States, including EPA [and Settling Federal Agencies].
[bookmark: _Ref306879941][bookmark: _Toc68181636]STATEMENT OF FACTS
[bookmark: _Ref295487120][bookmark: _Ref290297920][Add Site name and describe location, description, National Priorities List status and add brief statement of historical hazardous substance activity at the Site.]
Hazardous substances have been or are threatened to be released at or from the Site. [NOTE: Additional information about specific hazardous substances present on- or off-site may be included.]
As a result of the release or threatened release of hazardous substances, EPA has undertaken response actions at or in connection with the Site under Section 104 of CERCLA, 42 U.S.C. § 9604, and will undertake response actions in the future. [OPTIONAL: Insert brief description of response actions undertaken at the Site to date by EPA or other persons, noting whether a removal, remedial investigation/feasibility study, or record of decision has been completed. Describe briefly any prior settlements for performance of work at the Site.]
In performing these response actions, EPA has incurred and will continue to incur response costs at or in connection with the Site. [NOTE: The dollar amount of costs incurred as of a specific date should be included. Describe briefly any previous cost recovery settlements under which any of these costs have been reimbursed to EPA by site potentially responsible parties (PRPs).]
[Identify each Respondent (and each SFA, if any) and its relationship to the Site. If Respondents (or SFAs) are numerous, state generally that: Each Respondent listed on Appendix A [and each Settling Federal Agency] arranged for disposal or treatment, or arranged with a transporter for transport for disposal or treatment, of a hazardous substance owned or possessed by such Respondent [or such Settling Federal Agency], by any other person or entity, at the Site, or accepted a hazardous substance for transport to the Site that was selected by such Respondent [or such Settling Federal Agency].]
[bookmark: _Ref306881151][In one or more paragraphs, present in summary fashion the factual basis for EPA’s determination in Section VI that the amount of hazardous substances contributed to the Site by each Respondent (and each SFA, if any) and the toxic or other hazardous effects of the substances contributed to the Site by each Respondent (and each SFA, if any) are minimal in comparison to other hazardous substances at the Site. The language will vary depending upon the criteria established for the particular settlement. An example follows:
The amount of hazardous substances contributed to the Site by each Respondent [and each Settling Federal Agency] does not exceed [insert either: “___% of the hazardous substances at the Site,” or “___ pounds/gallons of materials containing hazardous substances,”] and the hazardous substances contributed by each Respondent [and each Settling Federal Agency] to the Site are not significantly more toxic or of significantly greater hazardous effect than other hazardous substances at the Site.] [NOTE: Where practicable, an attachment listing the volume and general nature of the hazardous substances contributed to the Site by each Respondent (and each SFA, if any), to the extent available, may be included as an appendix. The total estimated volume of hazardous substances at the Site should be noted on the attachment, if one is used.]
EPA estimates that the total response costs incurred and to be incurred at or in connection with the Site by the EPA Hazardous Substance Superfund and by other persons is [insert either: “$______” or “between $______ and $______”]. The payment required to be made by each Respondent [and by each Settling Federal Agency] pursuant to this Settlement Agreement is a minor portion of this total amount. [NOTE: The dollar figure inserted should include the total response costs incurred to date as well as the Agency’s projection of the total response costs to be incurred during completion of response actions at the Site. The response cost total should include costs of the United States and any other person at the Site.]
[bookmark: _Ref306879951][bookmark: _Ref306880036][bookmark: _Toc68181637]DETERMINATIONS
[bookmark: _Ref306714197]Based upon the Statement of Facts set forth above and on the administrative record for this Site, EPA has determined that: 
The [insert Site name] Site is a “facility” as that term is defined in Section 101(9) of CERCLA, 42 U.S.C. § 9601(9).
Each Respondent [and each Settling Federal Agency] is a “person” as that term is defined in Section 101(21) of CERCLA, 42 U.S.C. § 9601(21).
Each Respondent [and each Settling Federal Agency] is a “potentially responsible party” within the meaning of Section 122(g)(1) of CERCLA, 42 U.S.C. § 9622(g)(1).
There has been an actual or threatened “release” of a “hazardous substance” from the Site as those terms are defined in Section 101(22) and (14) of CERCLA, 42 U.S.C. § 9601(22) and (14).
The actual or threatened “release” caused the incurrence of response costs.
Prompt settlement with each Respondent [and each Settling Federal Agency] is practicable and in the public interest within the meaning of Section 122(g)(1) of CERCLA, 42 U.S.C. § 9622(g)(1).
As to each Respondent [and each Settling Federal Agency], this Settlement Agreement involves only a minor portion of the response costs at the Site within the meaning of Section 122(g)(1) of CERCLA, 42 U.S.C. § 9622(g)(1).
The amount of hazardous substances contributed to the Site by each Respondent [and each Settling Federal Agency] and the toxic or other hazardous effects of the hazardous substances contributed to the Site by each Respondent [and each Settling Federal Agency] are minimal in comparison to other hazardous substances at the Site within the meaning of Section 122(g)(1)(A) of CERCLA, 42 U.S.C. § 9622(g)(1)(A).
[NOTE: If Attorney General approval is not required for this settlement because total past and projected response costs of the United States at the Site are not expected to exceed $500,000, insert next Paragraph.]
[bookmark: _Ref307307256][The total past and projected response costs of the United States at or in connection with the Site will not exceed $500,000, excluding interest.]
[bookmark: _Ref290298305]Based upon the administrative record for the Site and the Statement of Facts and Determinations set forth above, and in consideration of the promises and covenants set forth in this Settlement Agreement, the following is hereby AGREED TO AND ORDERED: 
[bookmark: _Ref306709408][bookmark: _Toc68181638]PAYMENT
[bookmark: _Ref306103448]Within 30 days after the Effective Date, each Respondent shall pay to EPA [insert either: “the amount set forth below” or “the amount set forth in Appendix C to this Settlement Agreement”].
[bookmark: _Ref380067721][bookmark: _Ref306880770]Each Respondent’s payment includes an amount for: (a) past response costs incurred at or in connection with the Site; (b) projected future response costs to be incurred at or in connection with the Site; and [insert, if a premium is included in the payment: (c) a premium to cover the risks and uncertainties avoided by participating in this settlement, including but not limited to, the risk that total response costs incurred or to be incurred at or in connection with the Site by the EPA Hazardous Substance Superfund, or by any other person, will exceed the estimated total response costs upon which Respondents’ payments are based.]
[NOTE: If some Respondents are paying a premium and some are not, Paragraph 17 will need to be redrafted to indicate that there are both premium and non-premium settling Respondents.]
[bookmark: _Ref306103499]Each Respondent shall make payment at https://www.pay.gov in accordance with the following instructions: enter “sfo 1.1” in the search field to access EPA’s Miscellaneous Payment Form – Cincinnati Finance Center. Complete the form, including the Site Name, docket number, and Site/Spill ID Number ______. 
[NOTE ABOUT SPECIAL ACCOUNTS: The Decree should specify whether payments made under Paragraph 16 should be deposited in the EPA Hazardous Substance Superfund, or in a site-specific special account within the EPA Hazardous Substance Superfund, or should be split between the Superfund and the Special Account (and should specify the split).]
[bookmark: _Ref380067184]Deposit of Payment. [Insert one of the following three sentences here.] [The total amount to be paid by Respondents pursuant to Paragraph 16 shall be deposited by EPA in the EPA Hazardous Substance Superfund.] [The total amount to be paid by Respondents pursuant to Paragraph 16 shall be deposited by EPA in the [Site name] Special Account to be retained and used to conduct or finance response actions at or in connection with the Site, or to be transferred by EPA to the EPA Hazardous Substance Superfund.] [Of the total amount to be paid by Respondents pursuant to Paragraph 16, [“$___” or “___%”] shall be deposited by EPA in the EPA Hazardous Substance Superfund, and [“$___” or “___%”] shall be deposited by EPA in the [Site name] Special Account to be retained and used to conduct or finance response actions at or in connection with the Site, or to be transferred by EPA to the EPA Hazardous Substance Superfund.]
Notice of Payment. At the time of payment, Respondent shall send notice that such payment has been made to [insert name  and email of Remedial Project Manager or other receiving official in Region]. Such notice shall reference Site Name, Site/Spill ID Number ______, and EPA docket number for this action
[NOTE ON REQUIRING ONE COLLECTIVE PAYMENT: If the settlement involves a large number of Respondents, it may be appropriate to include alternative instructions under which Respondents are to establish a short-term trust or escrow account to receive their individual payments and to make one collective payment to the Superfund, using one of the payment approaches set forth in Paragraph 18. In such event, the cost of the trust or escrow account may be funded from interest earned by the account or through other appropriate means.]
[NOTE: If Respondents will be making payment to a PRP-managed trust fund or escrow account established pursuant to an existing settlement with EPA, add the next paragraph. Also add to Paragraph 6 definitions for “Performing Parties” and “Performing Parties’ Response Costs.”]
[Payment to Performing Parties. Within 30 days after the Effective Date, each Respondent shall pay to Performing Parties $______, in payment of Performing Parties’ Response Costs. Payment shall be made to [insert instructions].]
[If SFAs are making payments, insert the following paragraph.]
[bookmark: _Ref306103534][As soon as reasonably practicable after the Effective Date, the United States, on behalf of each Settling Federal Agency, shall:
[bookmark: _Ref306880900]Payment to EPA
[bookmark: _Ref306103520][bookmark: _Ref306880889]Pay to EPA [insert either: “the amount set forth below” or “the amount set forth in Appendix __ to this Settlement Agreement”]. Each Settling Federal Agency’s payment includes an amount for: (1) past response costs incurred at or in connection with the Site; (2) projected future response costs to be incurred at or in connection with the Site; and [insert, if a premium is included in the payment: (3) a premium to cover the risks and uncertainties avoided by participating in this settlement, including but not limited to, the risk that total response costs incurred or to be incurred at or in connection with the Site by the EPA Hazardous Substance Superfund, or by any other person, will exceed the estimated total response costs upon which Settling Federal Agencies’ payments are based.] [NOTE: If some SFAs are paying a premium and some are not, this paragraph will need to be redrafted to indicate that there are both premium and non-premium SFAs.].
[Insert one of the following three sentences.] [The total amount to be paid by Settling Federal Agencies pursuant to Paragraph 22.a(1) shall be deposited by EPA in the EPA Hazardous Substance Superfund.] [The total amount to be paid by Settling Federal Agencies pursuant to Paragraph 22.a(1) shall be deposited by EPA in the [Site name] Special Account to be retained and used to conduct or finance response actions at or in connection with the Site, or to be transferred by EPA to the EPA Hazardous Substance Superfund.] [Of the total amount to be paid by Settling Federal Agencies pursuant to Paragraph 22.a(1), [“$___” or “___%”] shall be deposited by EPA in the EPA Hazardous Substance Superfund and [“$___” or “___%”] shall be deposited by EPA in the [Site name] Special Account to be retained and used to conduct or finance response actions at or in connection with the Site, or to be transferred by EPA to the EPA Hazardous Substance Superfund.].
[NOTE: If SFAs will be making payment to a PRP-managed trust fund or escrow account established pursuant to an existing settlement with EPA, add the next paragraph. Also add to Paragraph 6 definitions for “Performing Parties” and “Performing Parties’ Response Costs.”]
[bookmark: _Ref376859853][Payment to Performing Parties. Pay to Performing Parties $______, in payment of Performing Parties’ Response Costs, by Automated Clearinghouse (ACH) Electronic Funds Transfer in accordance with instructions provided by Performing Parties.]
[bookmark: _Ref306103589]Interest. In the event that payment required by Paragraph 22.a(1) [or Paragraph 22.b] is not made within 120 days after the Effective Date, the United States, on behalf of each Settling Federal Agency, shall pay Interest on the unpaid balance, commencing on the 121st day after the Effective Date and accruing through the date of the payment.
[bookmark: _Ref306880493][bookmark: _Toc68181639]FAILURE TO MAKE PAYMENT
[bookmark: _Ref306709518]If any Respondent fails to make full payment within the time required by Paragraph 16, that Respondent shall pay Interest on the unpaid balance, which shall accrue from the Effective Date until the date of payment. In addition, if any Respondent fails to make full payment as required by Paragraph 16, the United States may, in addition to any other available remedies or sanctions, bring an action against that Respondent seeking injunctive relief to compel payment and/or seeking civil penalties under Section 122(l) of CERCLA, 42 U.S.C. § 9622(l), for failure to make timely payment.
[bookmark: _Toc68181640]CERTIFICATION OF RESPONDENTS [AND SETTLING FEDERAL AGENCIES]
By signing this Settlement Agreement, each Respondent certifies, individually, that, to the best of its knowledge and belief, it:
has conducted a thorough, comprehensive, good faith search for documents, and has fully and accurately disclosed to EPA, all information currently in its possession, or in the possession of its officers, directors, employees, contractors or agents, that relates in any way to the ownership, operation, or control of the Site, or to the ownership, possession, generation, treatment, transportation, storage, or disposal of a hazardous substance, pollutant, or contaminant at or in connection with the Site; 
[bookmark: _Ref306709360]has not altered, mutilated, discarded, destroyed, or otherwise disposed of any records, reports, documents, or other information (including records, reports, documents, or other information in electronic form) (other than identical copies) relating to its potential liability regarding the Site since notification of potential liability by the United States or the state; and
has and will comply fully with any and all EPA and State requests for information regarding the Site pursuant to Sections 104(e), 122(e)(3)(B), and 122(g)(8) of CERCLA, 42 U.S.C. §§ 9604(e), 9622(e)(3)(B), and 9622(g)(8), and Section 3007 of RCRA, 42 U.S.C. § 6927, and state law. 
[If SFAs, insert: The United States acknowledges that each Settling Federal Agency (a) is subject to all applicable Federal record retention laws, regulations, and policies; and (b) has certified that it has fully complied with any and all EPA and State requests for information regarding the Site pursuant to Sections 104(e), 122(e)(3)(B), and 122(g)(8) of CERCLA, 42 U.S.C. §§ 9604(e), 9622(e)(3)(B), 9622(g)(8), and Section 3007 of RCRA, 42 U.S.C. § 6927, and state law.[footnoteRef:2]] [2:  EPA attorneys must assure that the Agency has received a written response to any information requests that it has sent to Settling Federal Agencies containing a certification substantially similar to that required from private PRPs.] 

[bookmark: _Ref306880242][bookmark: _Ref306880328][bookmark: _Toc68181641]COVENANTS BY UNITED STATES
[bookmark: _Ref306801724]Covenants for Respondents. Except as specifically provided in Section XI (Reservations of Rights by United States), the United States[footnoteRef:3] covenants not to sue or take administrative action against any of the Respondents pursuant to Sections 106 or 107 of CERCLA, 42 U.S.C. §§ 9606 or 9607, [and Section 7003 of the RCRA, 42 U.S.C. § 6973,][footnoteRef:4] relating to the Site. With respect to present and future liability, these covenants shall take effect for each Respondent upon the Effective Date. With respect to each Respondent, individually, these covenants are conditioned upon: (a) the satisfactory performance by Respondent of all obligations under this Settlement Agreement; and (b) the veracity and completeness of the information provided to EPA by Respondent relating to Respondent’s involvement with the Site. These covenants extend only to Respondents and do not extend to any other person.  [3:  If any federal agency other than EPA or the U.S. Department of Justice, such as Coast Guard or Federal Emergency Management Agency, has or may incur response costs at the Site, such costs must either be addressed in the settlement or must be explicitly reserved in Paragraph 28.]  [4:  If including a RCRA § 7003 covenant in Paragraph 26 (and 27, if SFAs), pursuant to Section 7003(d) of RCRA, you must offer to have a public meeting regarding the settlement and hold such a meeting if requested. To do this, include language in the Federal Register notice providing for an opportunity for a public meeting in the affected area. For guidance regarding how to comply with this requirement, see “Revised Model Notice Language for Compliance with Public Participation Requirements of Section 7003(d) of RCRA” (Oct. 30, 1996), available at https://www.epa.gov/enforcement/guidance-model-language-compliance-public-participation-requirements-under-rcra-section.] 

[bookmark: _Ref306802036][If SFAs, insert: Covenant for Settling Federal Agencies. Except as specifically provided in Section XI (Reservations of Rights by United States), EPA covenants not to take administrative action against any of the Settling Federal Agencies pursuant to Sections 106 or 107 of CERCLA, 42 U.S.C. §§ 9606 or 9607, [and Section 7003 of the Resource Conservation and Recovery Act, 42 U.S.C. § 6973,] relating to the Site. With respect to present and future liability, this covenant shall take effect for each Settling Federal Agency upon the Effective Date. With respect to each Settling Federal Agency, individually, this covenant is conditioned upon: (a) the satisfactory performance by Settling Federal Agency of all obligations under this Settlement Agreement; and (b) the veracity and completeness of the information provided to EPA by Settling Federal Agency relating to Settling Federal Agency’s involvement with the Site. This covenant extends only to Settling Federal Agencies and does not extend to any other person.”] 
[bookmark: _Ref306880115][bookmark: _Ref306880190][bookmark: _Ref306880258][bookmark: _Ref306880361][bookmark: _Toc68181642][bookmark: _Ref290297688]RESERVATIONS OF RIGHTS BY UNITED STATES
[bookmark: _Ref306709571][bookmark: _Ref306880653] The United States reserves, and this Settlement Agreement is without prejudice to, all rights against Respondents [if SFAs, insert: and EPA and the federal natural resource trustees reserve, and this Settlement Agreement is without prejudice to, all rights against Settling Federal Agencies,] with respect to all matters not expressly included within Section X (Covenants by United States). Notwithstanding any other provision of this Settlement Agreement, the United States reserves all rights against Respondents [and EPA and the federal natural resource trustees reserve, and this Settlement Agreement is without prejudice to, all rights against Settling Federal Agencies,] with respect to: 
[bookmark: _Ref290298401]liability for failure to meet a requirement of this Settlement Agreement;
[bookmark: _Ref290298412]criminal liability;
liability for damages for injury to, destruction of, or loss of natural resources, and for the costs of any natural resource damage assessments;[footnoteRef:5]  [5:  This natural resource damage reservation must be included unless the federal natural resource trustee(s) has/have agreed to a covenant not to sue pursuant to Section 122(j)(2) of CERCLA. In accordance with Section 122(j)(1) of CERCLA, where the release or threatened release of any hazardous substances at the site may have resulted in damages to natural resources under the trusteeship of the United States, the Region should notify the federal natural resource trustee(s) of the negotiations and encourage the trustee(s) to participate in the negotiations.] 

[bookmark: _Ref306709380][bookmark: _Ref306103087]liability based on the ownership or operation of the Site by Respondents [or Settling Federal Agencies]; and
liability based on Respondents’ [or Settling Federal Agencies’] transportation, treatment, storage, or disposal, or arrangement for transportation, treatment, storage, or disposal, of a hazardous substance or a solid waste at or in connection with the Site, after signature of this Settlement Agreement by Respondents [or Settling Federal Agencies]. 
[bookmark: _Ref306881183]Notwithstanding any other provision in this Settlement Agreement, the United States reserves, and this Settlement Agreement is without prejudice to, the right to institute judicial or administrative proceedings against any individual Respondent seeking to compel that Respondent [if SFAs, insert: , and EPA reserves, and this Settlement Agreement is without prejudice to, the right to issue an administrative order to any individual Settling Federal Agency,] to perform response actions relating to the Site, and/or to reimburse the United States for additional costs of response, if: 
information is discovered that indicates that such Respondent [or such Settling Federal Agency] contributed hazardous substances to the Site in such greater amount or of such greater toxic or other hazardous effects that such Respondent [or such Settling Federal Agency] no longer qualifies as a de minimis party at the Site because [insert volume and toxicity criteria from Paragraph 12 of the Statement of Facts, e.g.: such Respondent [or such Settling Federal Agency] contributed greater than ___% of the hazardous substances at the Site, or contributed hazardous substances that are significantly more toxic or are of significantly greater hazardous effect than other hazardous substances at the Site]; or
[NOTE: The cost overrun reopener in Paragraph 29.b should only be included with respect to any Respondent (or any SFA) who is not paying a premium in lieu of this reopener.]
[bookmark: _Ref306881180][total response costs incurred or to be incurred at or in connection with the Site by the United States or any other person exceed $______ [insert total response costs estimate upon which Respondents’ (and SFAs’) payments are based]. [NOTE: If some Respondents are paying a premium in lieu of the cost overrun reopener and some are not, insert: This Paragraph 29.b shall not apply to those Respondents [and those Settling Federal Agencies] identified [insert: “in Paragraph ___” or “in Appendix ___”] who have elected to pay a premium amount pursuant to Paragraphs 16 and 17 [if SFAs, insert: (for Respondents), or Paragraph 22.a(1) (for Settling Federal Agencies).] 
[bookmark: _Ref306879883][bookmark: _Ref306880288][bookmark: _Ref306880303][bookmark: _Toc68181643]COVENANTS BY RESPONDENTS [AND SETTLING FEDERAL AGENCIES]
[bookmark: _Ref380068002][bookmark: _Ref306863743]Covenants by Respondents 
Respondents covenant not to sue and agree not to assert any claims or causes of action against the United States or its contractors or employees with respect to the Site and this Settlement Agreement[footnoteRef:6] including, but not limited to: [6:  The covenants by the United States, Paragraph 26 (and 27, if applicable), are drafted to resolve fully Respondents’ (and SFAs’) liability for the Site as a whole. However, if this is not the case, the scope of Paragraph 30 (and 31) may be narrowed to conform to the scope of the United States’ covenants.] 

any direct or indirect claim for reimbursement from the EPA Hazardous Substance Superfund based on Sections 106(b)(2), 107, 111, 112, or 113 of CERCLA, 42 U.S.C. §§ 9606(b)(2), 9607, 9611, 9612, or 9613, or any other provision of law;
any claim arising out of response actions at or in connection with the Site, including any claim under the United States Constitution, the Constitution of the State [Commonwealth] of______, the Tucker Act, 28 U.S.C. § 1491, the Equal Access to Justice Act, 28 U.S.C. § 2412, or at common law; and
any claim pursuant to Sections 107 and 113 of CERCLA, 42 U.S.C. §§ 9607 and 9613, Section 7002(a) of RCRA, 42 U.S.C. § 6972(a), or state law regarding the Site. 
[bookmark: _Ref306803522]Except as provided in Paragraph 33 (waiver of claims) and Paragraph 38 (waiver of claim-splitting defenses), these covenants not to sue shall not apply in the event the United States brings a cause of action or issues an order pursuant to any of the reservations set forth in Section XI (Reservations of Rights by United States), other than in Paragraph 28.a (liability for failure to meet a requirement of the Settlement Agreement) or 28.b (criminal liability), but only to the extent that Respondents’ claims arise from the same response action, response costs, or damages that the United States is seeking pursuant to the applicable reservation.
[bookmark: _Ref306863752][bookmark: _Ref380068015][If SFAs, insert: Covenant by Settling Federal Agencies. Settling Federal Agencies agree not to assert any direct or indirect claim for reimbursement from the EPA Hazardous Substance Superfund through CERCLA §§ 106(b)(2), 107, 111, 112, 113 or any other provision of law with respect to the Site and this Settlement Agreement. This covenant does not preclude demand for reimbursement from the Superfund of costs incurred by a Settling Federal Agency in the performance of its duties (other than pursuant to this Settlement Agreement) as lead or support agency under the NCP.] 
Nothing in this Settlement Agreement shall be deemed to constitute preauthorization or approval of a claim within the meaning of Section 111 of CERCLA, 42 U.S.C. § 9611, or 40 C.F.R. § 300.700(d). 
[bookmark: _Ref306709557][bookmark: _Ref380067861]Respondents agree not to assert any claims and to waive all claims or causes of action (including but not limited to claims or causes of action under Section 107(a) or 113 of CERCLA) that they may have for response costs [if natural resource damage claims are being resolved through this settlement, insert: and for natural resource damages and assessment costs] relating to the Site against each other or any other person who is a potentially responsible party under CERCLA at the Site. This waiver shall not apply with respect to any defense, claim, or cause of action that a Respondent may have against any person if such person asserts a claim or cause of action relating to the Site against such Respondent. [NOTE: If a Settling Defendant asserts that it has a claim against a PRP within the scope of this waiver that is unrelated to the PRP’s CERCLA liability at the Site, e.g., a claim for contractual indemnification, add an exception for such claim such as the following: This waiver also shall not apply to Settling Defendant’s contractual indemnification claim against [insert name].]
[bookmark: _Toc68181644]EFFECT OF SETTLEMENT/CONTRIBUTION
[bookmark: _Ref306709545]Except as provided in Paragraph 33 (waiver of claims), nothing in this Settlement Agreement shall be construed to create any rights in, or grant any cause of action to, any person not a Party to this Settlement Agreement. Except as provided in Section XII (Covenants by Respondents [and Settling Federal Agencies]), each of the Parties expressly reserves any and all rights (including, but not limited to, pursuant to Section 113 of CERCLA, 42 U.S.C. § 9613), defenses, claims, demands, and causes of action that each Party may have with respect to any matter, transaction, or occurrence relating in any way to the Site against any person not a Party hereto. Nothing in this Settlement Agreement diminishes the right of the United States, pursuant to Section 113(f)(2) and (3) of CERCLA, 42 U.S.C. § 9613(f)(2)-(3), to pursue any such persons to obtain additional response costs or response action and to enter into settlements that give rise to contribution protection pursuant to Section 113(f)(2). 
[bookmark: _Ref306103362]The Parties agree that this Settlement Agreement constitutes an administrative settlement pursuant to which each Respondent [and each Settling Federal Agency] has, as of the Effective Date, resolved liability to the United States within the meaning of Sections 113(f)(2) and 122(g)(5) of CERCLA, 42 U.S.C. §§ 9613(f)(2) and 9622(g)(5), and is entitled, as of the Effective Date, to protection from contribution actions or claims as provided by Sections 113(f)(2) and 122(g)(5) of CERCLA, or as may be otherwise provided by law, for the “matters addressed” in this Settlement Agreement. The “matters addressed” in this Settlement Agreement are [all response actions taken or to be taken and all response costs incurred or to be incurred, at or in connection with the Site, by the United States or any other person],[footnoteRef:7] except for the State;[footnoteRef:8] provided, however, that if the United States exercises rights under the reservations in Section XI (Reservations of Rights by United States), other than in Paragraph 28.a (liability for failure to meet a requirement of the Agreement) or 28.b (criminal liability), the “matters addressed” in this Settlement Agreement will no longer include those response costs or response actions [if the Agreement includes a natural resource damages settlement include: or natural resource damages] that are within the scope of the exercised reservation.  [7:  This definition of “matters addressed” assumes that this Settlement Agreement is designed to resolve fully Respondents’ (and SFAs, if any) liability at the Site. If the intended resolution of liability is narrower in scope, then the definition of “matters addressed” will need to be narrowed.]  [8:  If the State is a party and is resolving its claims regarding the Site through this Agreement, delete “except for the State.” Note that State claims do not include claims for EPA Hazardous Substance Superfund costs that have been provided to the State through a cooperative agreement with EPA and for which EPA retains the responsibility for cost recovery.] 

The Parties further agree that this Settlement Agreement constitutes an administrative settlement pursuant to which each Respondent [if SFAs insert: and each Settling Federal Agency] has, as of the Effective Date, resolved liability to the United States within the meaning of Section 113(f)(3)(B) of CERCLA, 42 U.S.C. § 9613(f)(3)(B ). 
Each Respondent shall, with respect to any suit or claim brought by it for matters related to this Settlement Agreement, notify EPA in writing no later than 60 days prior to the initiation of such suit or claim. Each Respondent shall, with respect to any suit or claim brought against it for matters related to this Settlement Agreement, notify EPA in writing within 10 days after service of the complaint or claim upon such Respondent. In addition, each Respondent shall notify EPA within 10 days after service or receipt of any Motion for Summary Judgment and within 10 days after receipt of any order from a court setting a case for trial, for matters related to this Settlement Agreement. 
[bookmark: _Ref306103796]In any subsequent administrative or judicial proceeding initiated by the United States for injunctive relief, recovery of response costs, or other relief relating to the Site, Respondents shall not assert, and may not maintain, any defense or claim based upon the principles of waiver, res judicata, collateral estoppel, issue preclusion, claim-splitting, or other defenses based upon any contention that the claims raised in the subsequent proceeding were or should have been brought in the instant action; provided, however, that nothing in this Paragraph affects the enforceability of the covenants set forth in Section X (Covenants by United States).
[bookmark: _Ref306709590]Effective upon signature of this Settlement Agreement by a Respondent, such Respondent agrees that the time period commencing on the date of its signature and ending on the date EPA receives from such Respondent the payment(s) required by Section VII (Payment) and, if any, Section VIII (Failure to Make Payment) shall not be included in computing the running of any statute of limitations potentially applicable to any action brought by the United States related to the “matters addressed” as defined in Paragraph 35, and that, in any action brought by the United States related to the “matters addressed,” such Respondent will not assert, and may not maintain, any defense or claim based upon principles of statute of limitations, waiver, laches, estoppel, or other defense based on the passage of time during such period. If EPA gives notice to Respondents that it will not make this Settlement Agreement effective, the statute of limitations shall begin to run again commencing 90 days after the date such notice is sent by EPA.
[bookmark: _Toc68181645]INTEGRATION/APPENDICES
This Settlement Agreement and its appendices constitute the final, complete, and exclusive agreement and understanding among the Parties with respect to the settlement embodied in this Settlement Agreement. The Parties acknowledge that there are no representations, agreements, or understandings relating to the settlement other than those expressly contained in this Settlement Agreement. The following appendices are attached to and incorporated into this Settlement Agreement:
“Appendix A” is [the list of Respondents].
“Appendix B” is [the map of the Site].
“Appendix C” is [the payment schedule].
[NOTE: List any additional appendices.]
[bookmark: _Toc68181646]PUBLIC COMMENT
[bookmark: _Ref306881711]This Settlement Agreement shall be subject to a public comment period of at least 30 days pursuant to Section 122(i) of CERCLA, 42 U.S.C. § 9622(i). In accordance with Section 122(i)(3) of CERCLA, 42 U.S.C. § 9622(i)(3), EPA may withdraw or withhold its consent to this Settlement Agreement if comments received disclose facts or considerations that indicate that this Settlement Agreement is inappropriate, improper, or inadequate.
[bookmark: _Toc68181647]ATTORNEY GENERAL APPROVAL
[NOTE: This Section should be used if Attorney General approval is required for this settlement because total past and projected response costs at the Site will exceed $500,000, excluding interest. The Region should consult with the U.S. Department of Justice (DOJ) during the negotiations process and should obtain written DOJ approval of the settlement before publishing notice of the proposed Settlement Agreement in the Federal Register pursuant to Section 122(i) of CERCLA. The Region should discuss with DOJ any significant comments received during the public comment period. If the Region believes that the Settlement Agreement should be modified based upon public comment, the Region should discuss with the DOJ attorney assigned to the case whether the proposed change will require formal re-approval by DOJ.]
[The Attorney General or [his/her] designee has approved the settlement embodied in this Settlement Agreement in accordance with Section 122(g)(4) of CERCLA, 42 U.S.C. § 9622(g)(4).]
[bookmark: _Ref306879994][bookmark: _Toc68181648]EFFECTIVE DATE
The effective date of this Settlement Agreement shall be the date upon which EPA issues written notice that the public comment period pursuant to Paragraph 41 has closed and that comments received, if any, do not require modification of or EPA withdrawal from this Settlement Agreement. [NOTE: This notice should inform Respondents (and SFAs, if any) that payment is now due in accordance with Paragraph 16 (and 22).]

IT IS SO AGREED AND ORDERED:


					U.S. ENVIRONMENTAL PROTECTION AGENCY:


_____________			_____________________________
Dated					[Name]
					Regional Administrator, Region __

[NOTE: If the Regional Administrator has redelegated authority to enter into de minimis settlements, insert name and title of delegated official.]


Signature Page for Settlement Agreement Regarding ______ Superfund Site

[If Settling Federal Agencies, insert signature blocks for each settling federal agency. If SFAs are numerous or signature by the agency is otherwise impractical, DOJ/Environmental Defense Section may exercise its discretion to sign on behalf of the SFAs.]	

					FOR SETTLING FEDERAL AGENCY:



_____________			_____________________________________
Dated					[Name]
 					[Chief]
					U.S. Department of Justice
					Environment and Natural Resources Division
					Environmental Defense Section
					P.O. Box 7611
					Washington, D.C. 20044-7611]
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Signature Page for Settlement Agreement Regarding ______ Superfund Site


					
FOR ____________________________________:
							[Print name of Respondent]


_____________			_________________________________________
Dated					[Name]
					[Title]
					[Company]
					[Address]

[NOTE:  A separate signature page is required for each settlor.]






Instructions Regarding Automated Features

	Feature
	Instructions

	Inserting text copied from a different document
	Text copied from a different document will usually have embedded formatting codes. Pasting the text into your document will cause the formatting codes to be inserted as well, which will create unpredictable and frustrating formatting and numbering results. Therefore, ALWAYS use the “Paste Special” function to insert text copied from another document. Press Ctrl-Alt-V; in the pop-up menu, click “Unformatted Text” and OK. (You can also click the Home tab, Paste, Paste Special, Unformatted Text and OK.)

	Inserting a new paragraph
	Click at the end of the ¶ immediately preceding the place where you wish to add the new paragraph, and press Enter. To change the new ¶'s outline level use (under the Home tab) the styles menu. For example, to change ¶12.b into ¶12.a(1), click in that ¶ and then (using the Home tab) click the "LVL 3" style. To change ¶13.a into ¶14, click in that ¶ and then (using the Home tab) click the  “LVL 1” Style. Note that in consent decree models, the letters denoting each background paragraph must be manually updated.

	Adding an updateable section or paragraph cross-reference
	(a) Click where you wish to insert a cross-reference; (b) Click the “References” tab, and, in the “Captions” box, click “Cross-reference;” (c) In the pop-up menu that appears, make sure the “Reference type” field contains “Numbered item” and the “Insert reference to” field contains “Paragraph Number (full context); (d) In the “For which numbered item” field” select the numbered item (section, paragraph. or subparagraph) you wish to cross-reference, and click Insert.

	Updating the cross-references
	Press Ctrl-A (to select entire document); right click; in the pop-up menu, click “Update Field;” click OK. Note: If a numbered paragraph that has been cross-referenced elsewhere in the document is deleted, remove the obsolete paragraph cross-reference. Otherwise, when you update the cross-references, the following message will appear: “Error! Reference source not found.”

	Updating the table of contents
	Right-click in the TOC, and in the pop-up menu, left-click “Update Field.” Or click in the TOC, press F9, click Update Entire Table and OK. If you have just added a new section heading, click Update entire table before pressing Enter.

	Inserting a new section heading
	Click in the text of the new heading and assign the “SECTION” paragraph style to the text by clicking the “Home” tab, and in Styles box, clicking the “SECTION” style button.) That will add the section number, change the numbering of later sections, and ensure that the new section will be referenced in the table of contents.

	Changing the font
	Press Ctrl-A (to select entire document); right click; in the pop-up menu, click “Font;” in the “font” field, select a new font; click OK.



